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Application structure
Parts of the system

Tabular package consists of 3 parts.

1. Tabular Excel add-in — this is the main Excel add-in which is an application level add-in.
2. Narrative reporting Word add-in – this is a helper Word add-in which allows you to extract values from

Excel workbooks and help you create RSR and SFCR reports
3. Downloadable zip file which we refer as Tabular main workbook or Tabular main entry point. This zip

file contains the main entry point of the system (where you create your returns from) as well as the
database file and the template workbook that contains all application excel sheets. It also contains
some helper files as well as the log files of the application.

Database

We are using SQL server compact which is a serverless database, which means it is just a file in the file
structure. No need for setting servers, modifying firewalls and can work offline without access to internet.

Detailed info on the application you can find here.
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Client
Supported Operating Systems:
Windows 7 or later

Supported Microsoft Office:
2010 or later (32bit and 64bit)

Other Supporting software
Installation Prerequisites

Recommend PC Spec:
8GB RAM+ and i5 CPU+ (or equivalent)

For using Tabular on small data sets:
4GB RAM and i5 CPU (or equivalent) should be sufficient

Other Notes
Note that lower spec machines can also load tabular as long as they can run Excel, however performance
will be slower in some resource demanding operations like import, validation, Create return.
Tabular can also run on Office 2007 and Windows XP, however there will be some limitations and in general
we don’t recommend using the two and this combination is not officially supported.
Tabular doesn’t support online version of Excel as it does not support Com add-ins.
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Tabular initial setup
We recommend doing the first installation with a member of our support team, so we can assist you in any
configuration required for your environment and answer any questions that may arise. We have provided full
installation instructions in the subsections of this article, but we would appreciate if the first installation is
done under our observation which will also help us in supporting you in the long term.
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Prerequisites
Here are all the client prerequisites needed to run Tabular. They are all free Microsoft products.

1) Microsoft .Net Framework 4.0 or later
2) Microsoft SQL Server Compact 4.0 SP1
3) Open XML SDK 2.5 for Microsoft Office
4) Visual Studio 2010 Tools for Office Runtime (it is included in the installation package of Office 2010 and
2013 by default)
5) Microsoft Office 2010 or later
6) Windows 7 or later

Please also consider the client machine specification:

Supported Client Environment
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Files needed
After you have installed the prerequisites you need to download 3 files from our website for the installation.
Enter the customer area (Support -> Products Download) of http://www.solvencyiisolutions.com and log with
the credentials provided from the support team. Then navigate to Downloads -> Latest:

Download the Excel Add-in installer – Tabular (Tabular_3.0.3.0.msi) or Advanced Tabular Installer(if not
installing from user’s Windows account), Narrative Report (NarrativeReport_3.0.3.0.msi), Tabular Workbook
3.0.3.0.zip . You will need these files to install both the Excel and Word add-ins.
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Installing Tabular Excel Add in
Tabular application is an Excel add-in and below you can find the installation steps you need to follow.

Installation steps:

1. Verify that you have all the prerequisites installed.

2. There will be two versions of the installer available (one version installs only for current user by adding
registry entries to the HKCU hive and the other installs to all users- adding registry entries to HKLM hive )
Download the .msi file you need from the download section of our website (Support -> Products Download).
Proceed with the installation of the downloaded .msi file.

• To install only for the current user – log in as the user that will be using Tabular and install
Tabular_x.x.x.x.msi.

• To install for all users – log in as any user or local Admin and use the
Tabular_AllUsers_Installer_x.x.x.x.msi.
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Tabular main workbook
Unlike the Tabular add-in which have to be installed on everyTabular user’s machine the main workbook is a
shared resource, so its set up only once at a shared location and then all users access it from there. Setting
up the Tabular main workbook is done only once when Tabular is installed for the first time. You don’t need
to perform this every time when you upgrade to a new version and instead you should use the One click
upgrade functionality to update the data.

Setup steps:

1. Download the Tabular Main Workbook zip file (Tabular_x.x.x.x.zip) from the download section of our
website (Support -> Products Download).

2. Check if the file is not blocked by your network protection.Do that by right clicking on the zip file, navigate
to properties and if there is a button labelled “Unblock”, click it.

3. Then unzip the file to where you want the Tabular entry point (this is where you create returns from and
the Database file is placed). It should be placed on a shared network drive that all user have read/write
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access as the Database file is in this file structure and every user will connect to it.

4. As the system keeps in database and in Excel workbooks some paths that should be absolutely the same
for all users. You need to configure if the system will use mapped drive paths or UNC paths. UNC path is
the default configuration for Tabular which should work in most setups. In some cases though like when
using DFS replication you might need to change this configuration and ensure all Tabular users have the
same mapped letter drive to the location of the Tabular files. More information and steps to do this
configuration you can find here. If you have a more complex network structure you can contact our support
and they will help you with the setup.
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Tabular configuration

Setting Database path type
Tabular keep the full paths to the database files in the return files and also the paths to return workbooks in
the database. How this paths are kept is configurable and they can be kept either in UNC format or use
mapped drive letters. By default it is setup to use UNC, but in some cases – for example when using
Replication servers you might want to change to use mapped drives. In such cases you need to make sure
all users have the same mapped drive letters to ensure paths are the same for them.
To change the this configuration follow the steps:
1. Open Tabular.xlsm and log with Administrator user
2. Navigate to System Admin -> Network Paths -> select Mapped Drive

3. Close Tabular.xlsm
4. Delete the file Tabular\ProgramData\connectionSettings.xml and start Tabular.xlsm again to regenerate
the file
5. If you are just starting with Tabular that is all. After that all returns you create will use mapped drive paths
however if you already have returns created you will need to update their paths to be correct. Please
contact Support to help you do that and make sure all returns paths are aligned with the new scheme.

Caching solution
As Tabular is using SQL server compact which is a serverless database which is a little bit heavier on the

Solvency II Solutions Technical Guide - 6.0.0.0

Page 11 of 64



data transfer we are using LocalAPPDATA\Temp for a caching solution. On initial start of Tabular we copy a
.zip file containing Tabular.sdf file inside to the mentioned folder and then unzip it. Then a lot of processes
are actually getting data from there thus reducing the load on the network and increasing performance in
case on a small bandwidth. A lot of companies tend to use roaming profiles or Citrix servers and clear
LocalAPPDATA\Temp folder on log off and in this way this initial copying of the caching solution will be
executed every time Tabular is started which will negatively impact performance.
If you have any restrictions on this folder for specific files(antivirus etc..) or you are clearing LocalAPPDATA\
Temp you can either:
1. Add exclusion in your policies for Tabular.sdf file
2. Contact our support team and they will help you setup the caching folder to some other folder which will
be more suitable for your environment.

Configuring Antivirus program
Clients with more aggressive Antivirus profiles sometimes have problems with logging into the database or
upgrading it to new version. As Tabular is using a serverless database (SQL Server Compact edition) which
is a file in your file system it can be locked by your Antivirus thus stopping any interactions with the
database file. If you are experiencing such problems you can add exclusion to you Antivirus for
ProgramData folder inside Tabular file structure or at least for the database file Tabular.sdf.

Solvency II Solutions Technical Guide - 6.0.0.0

Page 12 of 64



Verify installation successful
The Installation is considered successful if you can see the Tabular Add-in as active in the Add-in options of
Excel and when you open your Tabular.xlsm workbook (with the Windows user account of the installed
business user) you are presented with a Tabular log-in dialog.

Please follow this article from Microsoft to verify what Add-ins you have installed:

Check your installed Add-ins
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Installing on a Citrix server
If you are installing Tabular on a Citrix server there are few differences and additional steps that need to be
done.

Tabular software have two parts. One is the actual application which you install with .msi file and there is a
set of files (we call it Tabular Main Workbook) you receive in a zipped format that you unzip at some
network location that the users have full access to. This set of files contain some templates, the Database
file and some additional helper files. This set of files have nothing Citrix specific, so you can check how to
setup it from here.

Steps to setup the Tabular application:

1. After you have installed prerequisites – Install on the Citrix server the latest version of
Tabular_x.x.x.x.msi. Don’t use the “All users installer” as this will add some registry entries for all users
(HKLM) on the Citrix server and enable Tabular for all Excel users on machine and usually you don’t want
that.

2. After you have installed Tabular you need to spam this registry entries to all users that will be using
Tabular. You can do that manually, using group policies or any other third party software. Tabular registry
entries you can find here: HKEY_CURRENT_USER\Software\Microsoft\Office\Excel\Addins\Tabular

3. Next step is to publish the Excel application. Note that you should publish Excel with Tabular add-in
enabled and not just a specific file (Tabular.xlsm for example- this is the entry point of the system placed in
the set of files listed above)

4. If you have multiple Citrix servers to share the load- you need to do the above 3 steps for all of them.
There is also one more thing to note – if some of your Citrix servers are 64 bit and some are 32 bit you will
need to add different registry entries for each as the registry entries contain a path to Program files and in
case it’s 32 bit the path is different.

If in future you need to update the version of Tabular you just have to uninstall the current application
version you have and install the new one – no need to set the registry entries again.

If any problems or questions arise do not hesitate to contact our support team and they will be glad to help
you setup Tabular.
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Installing Tabular Word Add-in
Narrative reporting application is an Word document level add-in and below you can find the installation
steps you need to follow.

Installation steps:

1. Download the NarrativeReport_x.x.x.x.msi file from the download section of our website (Support ->
Products Download).

2. Proceed with the installation of the downloaded .msi file.

3. As the Word add-in is a document level add-in, when you first start a narrative report document(this is a
specific word file that will be created from Tabular excel add-in), a dialog will show that will ask you to install
the add-in. Click install to enable the Add-in for the document. In some cases this dialog will be blocked if it
is placed on a shared network drive. To make it work you will have to add the location of the file in Word’s
Trusted locations. To do that navigate to Trusted locations in Word options, check the “Allow trusted
locations on my network” option and click on “Add new location” button.
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Then in the dialog check “Subfolders of this location are also trusted” and browse to the path where you
keep your returns.This will allow the add-in to install for this document as expected.

4. To test if it is working use the word templates from this link as Narrative reporting needs specific Word
files to trigger generated on return creation.
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Installing on Replicated servers or Dropbox

Tabular files placed on replicated servers
Tabular supports setting the Tabular database and return workbook files on a replicated servers (storages)
environment however there are few additional configurations that should be considered.

1. The type of paths Tabular should use should align with your server configuration:

• If you have set up Domain-based (DFS) namespaces you should change Tabular path type setting to
use UNC paths, ie so for all Tabular users the path Tabular will use will be the same. Your server
replication algorithm will then control which user connects to which server based on load or custom
rules. Check this help article for information on how to change the Tabular path type setting to use
UNC paths.

• If you have not setup the domain based namespace, this means that you will have multiple servers
with different name eg //server1/Tabular (local server to user1) and //server2/Tabular (local server to
user2). As in this scenario you will want user1 to connect to server 1 and user 2 to connect to server 2
we will need a windows mapping that is the same for both users, but mapped to different servers.
Both users will have Tabular mapped to the same drive eg Z:/ but one user1 will be mapped to
//server1/Tabular and user2 will be mapped to //server2/Tabular . The Tabular path type setting
should be set to mapped drive (check link above). If this is not set correctly either some of the users
won’t be able to connect to Tabular or they will have slow performance as they will not be accessing
the files via their local server (which can be in a different country etc..)

2. Additionally if you have any restrictions on what is replicating its best to discuss that with our support
team, so they can explain if that will affect Tabular normal operation.

Tabular files placed on Dropbox
Tabular supports Dropbox for multiple users only with a specific setup. As Tabular relies on windows paths
to the database and to the Tabular returns, it will work only in case Tabular files are mapped to the same
folder for all the users. So if you have multiple users their Dropbox folder should be mapped to the same
path on their PC. So if they both map Dropbox to C:\Dropbox then it will work, but if they map to C:/Users/
user1/Dropbox and C:/Users/user2/Dropbox Tabular will work correctly for only one of the users as the
paths will be different for both.

P.S. Note that with both replicating servers and Dropbox some limitations will apply. As Tabular is an Excel
add-in and use Excel workbooks limitations based on simultaneous changes of the same file by 2 users on
different servers apply. Basically last saved wins and the changes of one of the user might get lost. This is
limitation of the replication process and users should be aware of that. Also we advise when some
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processes that modify returns and database like Create/Edit return/Team functionality users should make
sure that only this user is currently making changes to the database/files to avoid corruption.
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Upgrade
In this section you can find the different ways to upgrade add-in version as well as update Database data
and upgrade returns.
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Application Update
If you are on this page we have informed you of a Tabular application update. The download link to the
application installer should be included in the release email from us.
If you are not sure if you are on the latest Tabular application version, you can check that following the
instructions in this article.

How to upgrade:

1. Uninstall Tabular Excel Add-in version currently installed. You can do that from Add or remove programs.

2. Download the Tabular_x.x.x.x.msi file from the release link.

3. Proceed with the installation of the new version downloaded from our website. There will be two versions
of the installer available (one version installs only for current user by adding registry entries to the HKCU
hive and the other installs to all users- adding registry entries to HKLM hive )

a) To install only for the current user log in as the user that will be using Tabular and install
Tabular_x.x.x.x.msi.

b) To install for all users log in as any user or local Admin and use the
Tabular_AllUsers_Installer_x.x.x.x.msi.
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Data update
If you are on this page we have informed you of a Tabular data update. The download link to the update file
should be included in the release email from us.
If you are not sure if you are on the latest Tabular data version, you can check that following the instructions
in this article.

Before updating

If there is a Tabular application update specified in the release email, make sure you install that before
running the data update. You can check if you already have the latest application version following the
instructions in this article.

How to upgrade:

1. Download the Upgrade_x.x.x.x.zip file from the release link. Do not unzip it and do not place it into the
Tabular folder.

2. Right-click on the file and select properties and click on the Unblock button, then apply and save the
change.

3. Make sure all users are logged out of Tabular and have closed the return workbooks as a file might get
blocked and the upgrade fails.

4. In order to have access to the one click upgrade feature, you should open the main Tabular
workbook(Tabular.xlsm) and log with the Administrator user. The feature is disabled for all other users and
for specific returns.

5. Select from the ribbon System Admin -> One Click Upgrade if the upgrade dialogue doesn’t show by itself
after entering admin credentials.
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6. In the dialogue that shows select the upgrade file and click the Upgrade button. The process will take
some time(2 to 10 mins) depending on the speed of the machine and the size of the upgrade. Let it finish
until you get the success message, then restart Excel to finalize the upgrade.

Troubleshooting

If experience an error during the process and upgrade doesn’t complete with a success message, please
contact our support and they will assist you in recovering the database to its initial state from the back-up
created automatically before the upgrade.
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Upgrade DB
Upgrade DB option is used to upgrade the DB with a simple xml file. The file will be provided by our support
team.

How to upgrade DB:

1. In order to have access to the Upgrade DB feature, you should open the main Tabular workbook and
log with the Administrator user. The feature is disabled for all other users and for specific returns.

2. Select Upgrade -> Upgrade DB option from the ribbon

3. In the Window that shows open the Select dropdown, click on Add Return button and then navigate
and select the folder of the return you want to upgrade. Note that you can select multiple returns.
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4. In the list will be added the database for the selected return –check the select checkbox and click
apply script. In the dialog navigate to the upgrade file This will load the upgrade script.The process
will take some time depending on the number of returns upgraded, speed of machine and the size of
the upgrade. Let it finish until you get the success message, then restart Tabular to finalize the DB
upgrade.

Don’t interrupt the process as this might lead to corrupted database files. If something goes wrong and
upgrade doesn’t complete with a success message, please contact our support and they will assist you in
recovering the returns to their initial state from the back-up created automatically before upgrade.
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Upgrade to version 2.2.0.0
The 2.2.0.0 is a major release including the new taxonomy 2.1.0 which is needed for every filing for return
with reference date 31/12/2016 and after. To update to it you need to update both your add-in version(
installer) and run the One Click Upgrade to upgrade the database with the latest validations, formulas etc..
Here are the exact steps you need to perform to upgrade.

1. Uninstall your old Tabular add-in (version 2.1.0.0) from Add-remove programs for all users using Tabular.
2. Install the new 2.2.0.0 installer for all users using Tabular. The file is Tabular_2.2.0.0.msi (Note that if it is
installed from a different windows user than the one that will use Tabular you need to use the installer
labelled All users)
3. Download the Upgrade_2.2.0.0.zip file (don’t unzip it)
4. Close all opened Excel workbook and open the Tabular.xlsm from your current Tabular installation
(Tabular Main Workbook)
5. Log with Administrator account
6. Run One Click Upgrade using the Upgrade_2.2.0.0.zip file you downloaded and wait for it to finish and
while running don’t open any other Excel workbooks, note that it might take more time than usual depending
on number of returns you have created. Detailed instructions on the process here

Note that you should always install the new version of installer first and then run the One Click Upgrade.
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Upgrade to version 2.2.1.1
To update to latest 2.2.1.1 version you need to update both your add-in version( installer) and run the One
Click Upgrade to upgrade the database with the latest validations, formulas etc.. Here are the exact steps
you need to perform to upgrade. Note you can download all files from the download section of our website
using the login credentials provided to you.

1. Uninstall your old Tabular add-in (version 2.1.0.0) from Add-remove programs for all users using Tabular.
2. Install the new 2.2.1.0 application for all users using Tabular. The file to use is Tabular_2.2.1.0.msi (Note
that if it is installed from a different windows user than the one that will use Tabular you need to use the
installer labelled All users).
3. Download the Upgrade_2.2.1.1.zip file (don’t unzip it)
4. Close all opened Excel workbook and open the Tabular.xlsm from your current Tabular installation
(Tabular Main Workbook)
5. Log with Administrator account
6. Run One Click Upgrade using the Upgrade_2.2.1.1.zip file you downloaded and wait for it to finish and
while running don’t open any other Excel workbooks, note that it might take more time than usual depending
on number of returns you have created. Detailed instructions on the process here

Note that you should always install the new version of installer first and then run the One Click Upgrade.
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Narrative reporting Update
How to upgrade:

1. Uninstall Narrative reporting add-in. You can do that from Add or remove programs. Note that you should
uninstall two entries from Programs and features:

• Tabular Word Add-in
• TemplateDoc

2. Download the Narrative Report Word Application from the download section of our website.

3. Install Narrative_report_x.x.x.x.msi and follow the instructions.
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Check latest versions
You can check your current Tabular versions from the ribbon by going Tools -> About. In the dialog that
shows you can see both your application version and database version.
Current latest is:
Application: 2.2.1.0
Database: 2.2.1.1
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4.0.0.0 Technical details

Overview
The main technical changes to Tabular 4.0.0.0 are:

• Reduced Network Load (‘RNL’) setting
• Change of ‘local db’ path
• Use of sqlite databases and component

Technical details

RNL

This is set to ON by default in 4.0.0.0 but can be changed in System options. This configuration uses a local
cache of the main Tabular database for reading transactional Tabular data. Writes to the main Tabular DB
still happen with the network (main) Tabular DB, simultaneously with the local cache DB.
On the workbook save action the local DB is synced from the network; at this stage any other transactional
changes made (eg by other users in other returns) will be synced down to from the main DB to the local
cache DB.
Tabular technical logging is also sent to the local cache folder and saved up to network logging folder on the
save return action.
Additional, non-transactional, information is stored and read from the local folder (such as xbrl taxonomy
meta-data) for performance improvements.

Change of local DB path

The local folder, which was already in use before RNL but to a more limited extent, default path is changed
from ‘Temp’ to ‘%Appdata%\Tabular’.

Please note the default path can be updated (SystemAdmin > Settings > DB Options). In 4.0.0.0 paths
including %% are supported. Further, if you wish to reset the local path to the default set and empty path
and click OK.

SQLite usage

SQL CE is still used as the default DB format for the main Tabular (and local cache) DB. However, 4.0.0.0
runs calculations within a new ‘Data modelling’ feature on SQLite file format databases. These databases
represent the return workbook contents. Data modelling validations, for example comparing datasets from
two different returns, are executed within a SQLite temporary “query db” that imports from the SQLite files
representing the two different returns.
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Practical considerations of the technical changes

4.0.0.0 One-Click Upgrade ( ‘OCU’ )

The first one-click upgrade for 4.0.0.0. will take significantly longer than usual due to redesign of central
data structure and an associated one-time migration process
— each return workbook needs to undergo a one-time migration step to create the SQLlite return DB
— if a return is selected in OCU it will be migrated as well as the normal return upgrade process
— if a return is not selected in OCU it will not be migrated (which will mean the migration (creation of data
modelling save points) should occur manually -> which is to open that return and save it)
— note copies of workbooks will not be migrated as these are not known to tabular (but they can be
manually migrated in same way)

If you have had issues in the past with the upgrade process (particularly return upgrade part) running slowly
in the past, it would be advisable to run the upgrade overnight if possible as it will need to gain write access
to every return workbook within the Tabular system, in addition to the expected long-running time. it is
possible to run the upgrade process in several “runs”. Please contact support for step-by-step instructions or
a WebEx assistance.

New overhead to save process

The save action will incur two new process:
Sync of RNL main db to local, normally expected to be less than 5 seconds, depending on network speeds
Extraction of return information to SQLite, normally expected to be 1-2 seconds but for large workbooks
and/or slower networks can be slower. This process takes place after the successful save of the workbook.
The delay will occur after Excel updates the workbook header strip to confirm save complete. Note there is
no Tabular progress window for this step, during which Excel will be unresponsive.

New overhead to certain Tabular features

Data modelling functionality is built into some features. For example, running validations will create a new
SQLite “query db” for importing return information and performing calculations. Where the local app data
location is available to the user all of these actions will occur there. Otherwise they will occur on the main
tabular network location. Any users where the local app data is not available (and large return data
volumes) may see significant delays compared to previous validation performance times. Please note there
is configurability of the local data folder location so if the default path is not available but an alternative can
be set (for all users, as this path is shared across all users) this is possible.
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Licenses
Please refer to your contract for the details of your license and how you are allowed to use Tabular on your
network.
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Code Licenses
Tabular is written and owned by Solvency II Solutions Ltd. As a product it is not open source and you need
a license from Solvency II Solutions Ltd to use Tabular.

Tabular contains third party libraries that are open source. The licenses associated with these third party
libraries allow us to reuse, redistribute and sell these components as part of Tabular.

Tabular is commerical software, and all aspects of the Tabular product are fully supported. The conditions
for support can be found within your contract documentation.
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Troubleshooting
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Common Startup / Installation Issues
This section contains a list of common installation issues and how to fix them. For any issues that are not
listed here or the suggested solutions doesn’t help, don’t hesitate to contact our support team at:

Support email support@solvencyiisolutions.com
Support : 020 7193 8846
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Slow opening of Tabular on XP
There are some threads reporting slow performance (slow accessing the SQL Compact DB) on WIndows
XP. The workaround for this problem is the thread below :

https://social.msdn.microsoft.com/Forums/sqlserver/en-US/eb6a01a7-0bfd-41e3-b4c8-34581c5ccaa3/sql-
compact-4-locks-up-30seconds-when-accessing-encrypted-database-on-windows-xp-when-running-
in?forum=sqlce

https://social.technet.microsoft.com/Forums/sqlserver/en-US/1b21bb10-1fa3-4954-87d2-f3fa61e8256a/
sqlce-opens-slow-under-a-limited-user-account-in-windows-xp?forum=sqlce

Have in mind that although Tabular is working on Windows XP we recommend using with Windows 7 or
later.
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Tabular not starting & not in list of add-ins
If you installed Tabular, but when start Tabular.xlms nothing happens. Also Add-in is not in the list of both
active and inactive add-ins in the Add-ins section of excel options.

Most probably you have installed the Add-in from a different user account than the one you are starting it. In
this case you are missing some registry entries and the Add-in is not registered in Excel. You can double
check if this is the problem by checking the following registry entry for the user starting Tabular.xlsm:

HKEY_CURRENT_USER\Software\Microsoft\Office\Excel\Addins\Tabular

If this is missing you just have to install Tabular from the User that will be using the add-in to resolve. Also if
this is not possible or you prefer not to do it, you can use the All users installer from our website that adds
the registry entries for all users (to HKLM).

Solvency II Solutions Technical Guide - 6.0.0.0

Page 36 of 64



Tabular is in the list of inactive add-ins
If you installed Tabular, but when open either Tabular.xlsm or an existing return.xlsm file nothing happens (
you don’t get a login screen for Tabular). You have checked that the Add-in is installed and it is in the list of
inactive add-ins within Excel.

The Add-in might have been disabled (by windows or manually). You can fix this issue by following the
guidance from Microsoft here:

Activate Disabled Add-in

Alternatively if you are a first time user and have yet to run Tabular, you could be missing Visual Studio
2010 Tools for office runtime. This is one of the prerequisites which is usually distributed with the
installations of Office 2010 and 2013, however if you have manually excluded this component during the
installation of Office or you are using Office 2007 it is not installed on your system. In order to run Tabular
download this component and install it. Download link is below:

Visual Studio 2010 Tools Download
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Tabular not able to connect to DB
Tabular giving message that it can’t connect to DB on starting Tabular.xlsm.

Here are the things you can check in this case:
1. Is Microsoft SQL Server Compact 4.0 SP1 installed?
2. Have you unzipped before starting Tabular.xlsm (starting from the archiving program won’t work)
3. Have you unzipped Tabular workbook in a place you have full read/write access.
4. Is the ProgramData/Tabular.sdf file unblocked? (right click properties -> there should not be an Unblock
button)
5. In some environments the Antivirus program is blocking the communication between Tabular and its DB.
To check if this is the problem stop your antivirus program/service and check if Tabular will run. If yes so
there is a conflict with the Antivirus.
6. If you are using Microsoft Sync center to cache your network drive for work offline, sometimes it might
misbehave and block the database. To fix just stop/pause the sync or check in it for conflicts and resolve
them. Restart of the PC can also help.
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Tabular is working slow
There are few issues that might cause Tabular to work slow in general or some of the actions to be slow.

1. The machine it is installed on have lower than the Recommended specs. You can check them here.

2. The Main workbook and returns are saved on a shared network drive and the connection to this drive is
slow. Due to the architecture of the app there is an intensive data transfer between DB on network drive and
local PC and if the connection is bad this can affect performance.

3. If the problem persist please contact the support team and it will be good to send the log file as well and
our team will try to further help.
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Tabular loads the splash screen, but then
doesn’t progress to show the login screen
If the loading screen with message “ Please wait while Tabular Loads… “ runs indefinitely you may have a
conflict with another Add-in installed. Disable the other Add-ins installed, if any, and try again. If this helps
please contact Solvency II Solutions support and inform them of the Add-in that conflicted, so we can
research and fix the issue.
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Tabular add-in is unloaded and marked as
disabled
Sometimes after some crash or forcefully closing Excel the Tabular add-in might be unloaded and disabled
(called hard disable). To fix that follow the steps that are given in this Microsoft help article:

Fixing a hard disabled Add-In

Contacting our support team with attach the log file will also be helpful, so we can investigate what problem
caused this in the first place.
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Unable to find the requested .NET Framework
DataProvider
If you get an error like the one below follow this steps:

1. Check if all the prerequisites are installed: prerequisites

2. You may have corrupted machine.config file from .NET framework. Check this forum thread for more info:
http://stackoverflow.com/questions/23754055/sqlite-error-the-dbproviderfactories-section-can-only-appear-
once-per-config

To fix that you need to follow the instructions in the above thread:
Navigate to C:\Windows\Microsoft.NET\Framework\v4.0.30319\Config\machine.config, Note the right file is
machine.config and not machine.config.default ( if file extensions are hidden this is written as
“machine.config” only so it might get confusing)

Then you examine the file you should find two different tags like the one below:

Delete the second tag of this type that is empty(the one highlighted in the screenshot) and don’t forget to
create a backup of the file before you do this change. Then save the change and try running Tabular again.

This issue seems to be caused by IBM i Access for Windows installed on the machine Tabular is being
installed. The issue is fixed in their release version 7.1 as you can see in their change log — issue is under
number SE45767
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Tabular doesn’t start with error “Can’t access
a disposed object”

In some rare cases you can get the error message above when starting Tabular.xlsm or a return workbook.
It means that some object is hold in memory and there is an error accessing it. Usually the reason is if Excel
has crashed or have been stopped forcefully and an Excel/Tabular process is left running in the
background.

To fix it:
1. Stop all excel instances
2. Go to task manager -> Details tab
3. Find Excel process and end it. Then try running Tabular workbook again .
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Database access blocked by antivirus
Sometimes antivirus might be blocking proper access to the database. In such cases you might get some
messages on Create/Edit return like that:

Or on some actions like trying to export user data to support, it might give message like that:

To fix it IT team should set some exclusion to *.sdf (Tabular.sdf) files or altogether exclude Tabular folder
from their checks.
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Tabular not starting when double click on a
workbook – Excel 2016
With certain versions of Excel 2016 when double click on a Tabular workbook add -in will not start and all
the buttons in the Tabular ribbon will be disabled, but when open Excel first and then from its menu go File-
>Open and open a Tabular workbook the add in will load as expected and the log -in screen will show. To fix
the issue you need to upgrade your Excel version to the latest one available.
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“Object reference not set to instance of an
object” error
This can happen after a new installation if the location/workbook is considered not trusted. This seems to
happen either because excel considers every workbook downloaded from internet as not trusted or just
considers network location as such. When open any Tabular workbook you get the protected view strip on
top of the excel workbook. If you click Enable editing – the workbook is reloaded, but this causes Tabular to
show the “Object reference not set to instance of an object” error because it mess the loading events.
To fix that you can either add all Tabular locations to trusted locations in Excel-> Options -> Trust center or
just disable protected view from Excel -> Options -> Trust Center ->Protected view -> uncheck “Enable
protected view for files in untrusted locations” and/or uncheck “Enable protected view for files originating
from the internet”
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Add-in is unloaded and can’t be loaded again
When you use all users installer – Tabular add some entries to the HKLM – local machine hive of the
registry – one of this entries is load behavior of the add-in which by default is load at start up. Unfortunately
sometimes on a crash the Add-in gets unloaded — it actually adds this unloaded change to HKCU – current
user hive of the registry. So then a conflict happens and you can not load the add-in anymore as you
change the value in HKLM but the HKCU always stays unloaded and it has the higher priority.

Unfortunately this needs a change in the windows registry. At the bottom of the article there is a link to a reg
file – download it, unzip it and then run the file. This reg file will change the HKCU entry to load on start as
well. Note that in some client environment changing registry is disabled by IT so you might need to ask them
to do the change. Contact support if you need more info.

Download reg file
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Can not open the shared memory region
When following message is received:

There are few things to check:
1. Version of SQL Compact- if not latest SP1 version – it can cause the issue and you need to download
and install the latest version from the link in list of prerequisites.
2. Permissions in the folder of Tabular.sdf – make sure all users have read/write access.
3. Open the workbook from Excel: First open Excel and then use File -> Open
Instead of just double clicking on the workbook file.
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Common Upgrade Issues
This section contains a list of common upgrade issues and how to fix them. For any issues that are not
listed here or the suggested solutions doesn’t help, don’t hesitate to contact our support team at:

Support email support@solvencyiisolutions.com
Support : 020 7193 8846
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No Entity Framework provider found for the
ADO.NET provider
Sometimes a user might get an error like the one below on starting Tabular.

This problem happens when you are using a Citrix server and you copied manually some of the registry
entries to users different than the one installing the application. As in version 2.2.0.0 the registry entries
were changed you can’t start new 2.2.0.0 Tabular version with old registry entries and above error shows.
To fix that please contact our support team so they can provide the latest registry entries to you and assist
with the issue.
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Upgrade fails because DB is locked
If upgrade fails and in log you have:
Error duringUpgrading Database (Data File: UpgradeData2.sqlce) Error: There is a file sharing violation. A
different process might be using the file. [ \\Folder\folder1\Solvency-II\Tabular\Tabular Main Workbook\
ProgramData\Tabular.sdf ]

What this is saying is that something is locking the database. To fix:
1. Check if other users from your team are not logged into Tabular.
2. Close all Excel instances and check in Task Manager if there is not an Excel process left behind as this
sometimes happens and might be locking the file.
3. Restart your PC

Then run the upgrade again.

In most cases this should work. There are however there are 2 more cases where you can get this error that
might need some additional configuration:
1. Some antivirus configurations lock the database and it can’t be updated. To test just disabled the AV for a
while and try again. If that indeed was the problem an exclusion in antivirus policies should be made for
Tabular.sdf file.
2. If you are using Microsoft Sync center to cache your network drive for work offline, sometimes it might
misbehave and block the database. To fix just stop/pause the sync or check in it for conflicts and resolve
them. Note that usually restart of the PC will also help.
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Close all other workbook message
If when click on Upgrade button you get a dialogue saying “Please close all other workbooks” but you don’t
have any other workbooks opened apart from Tabular.xlsm

This usually indicate that you have some hidden workbooks opened. Sometimes workbooks are open on
starting Excel in order to execute a macro(registering a shortcut, etc..) and this workbooks are hidden. To
close them do the following:
From Excel ribbon go to Tab View -> Unhide
If some workbooks show unhide them and close and you will be able to proceed with upgrade.
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Common Error Messages

Download

Content from the website listed below is being blocked by the Internet Explorer
Enhanced Security Configuration. http://www.zuum.co.uk

Press Add... button and in Trusted sites dialog press Add button and close all dialog windows by
pressing Close. Refresh the page using F5 key.
Repeat the process if error is shown again with different site.

Install

The publisher could not be verified. Are you sure you want to run this software?
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Press Run.

This application requires .NET Framework 4.0.

Press Finish to close installation window. Install Microsoft .Net Framework from Prerequisites. Run
installation again.

Use this How To to determine which .NET Framework versions are installed*
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Run

The common language runtime could not be loaded by …\Tabular.vsto|vstolocal.
Contact your administrator for further assistance.

Problem with .NET Framework installation. Install Microsoft .Net Framework from Prerequisites.

Tabular ribbon tab doesn’t appear

Go to settings -> AddIns -> Manage: COM AddIns and look at the checkbox near Tabular. If it’s
unchecked and message is: Load behavior: Not loaded. The Managed Add-in Loader failed to
initialize.

Install Visual Studio 2010 Tools for Office Runtime from Prerequisites. Run Excel. Go to settings ->
AddIns -> Manage: COM AddIns. Check the checkbox near Tabular. Press OK
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Tabular ribbon tab doesn’t appear

Go to settings -> AddIns -> Manage: COM AddIns and look at the checkbox near Tabular. If it’s
unchecked and message is: Load Behavior: Not Loaded. A runtime error occurred during the loading
of the COM Add-in.

Close Excel. Set the VSTO_SUPPRESSDISPLAYALERTS environment variable to 0.

Run Excel. Go to settings -> AddIns -> Manage: COM AddIns. Check the checkbox near Tabular. Press O
K. You’ll see the loading error dialog.
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Press Details to see the error details. See Loading errors section for solution.

Open Tabular document

Unexpected error happened. Please fix following: ‘Unable to find the requested
.Net Framework Data Provider. It may not be installed.’.

Install Microsoft SQL Server Compact from Prerequisites.

Loading errors

Could not load file or assembly ‘…’ or one of its dependencies. Access is denied.

You don’t have Read permissions to one of Tabular components. Reinstall Tabular under current user.

Could not load file or assembly ‘…’ or one of its dependencies. The system
cannot find the file specified.

One of Tabular components doesn’t exist. Reinstall Tabular under current user.

Other errors
Please try to find your error on this page
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Narrative Reporting Issues
This section contains a list of common Narrative Reporting issues and how to fix them. For any issues that
are not listed here or the suggested solutions doesn’t help, don’t hesitate to contact our support team at:

Support email support@solvencyiisolutions.com
Support : 020 7193 8846
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I can’t see the Charts and Calculated fields
sections in Narrative reporting add-in
This two functionalities are available only for Word 2013 due to some limitations in the previous versions of
Word.
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Narrative reporting gives an error on start
NR add in not installing when start the Word document from network
The error looks like that:

This is a permission issue. When on a network location you should add this network location to the list of
trusted locations. Note that first you will have to check allow network locations to be added as trusted. Then
you will be able to install the add in to this document and start it. More info on how to do that you can find
here.
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Narrative reporting can’t download
TemplateDoc.vsto
Sometimes when starting narrative report file for first time (RSR, SFCR) you can get the below message:

This means that it can’t find the VSTO file it needs to start at the expected place. Usually this problem can
happen when you have more than one Tabular users and some of them are on 32 bit machines and some
on 64 bit machines, then when one of the user creates a return and generates RSR or SFCR documents
they add a path relating to his environment, so if 64bit user creates path is:
C:\Program Files (x86)\TabularWordAddin\TemplateDoc.vsto
This path won’t exist on the user with 32 bit machine.

To fix that just navigate to the proper path and manually start the TemplateDoc.vsto. The paths are:
C:\Program Files (x86)\TabularWordAddin\TemplateDoc.vsto
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C:\Program Files\TabularWordAddin\TemplateDoc.vsto

After that click install on the dialog and then you will be able to open the files.
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File not found message
You can get the below message on starting Narrative reporting:

This message means that the default selected Datasource can not be found. By defaul this source points to
the return with which the RSR/SFR are created, but if this file is moved or renamed it can’t be found.

To fix that go to DataSource manager and click “Change Path” button and then navigate to the file you want
to take data from:
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